
4

Contents
1. Computer Network 5

2. Log on To Access 15

3. Working with Queries, Forms and Reports 28

4. Cloud Computing 41

5. Introduction To Arduino 49

6. Looping Statements in Python 59

7. Robotics 68

8. Cyber Ethics 75

9. Introduction to App Development 82

10. Sound Editing With Audacity 94

 Fun Game 111



5 Computer-8

COMPUTER NETWORK1

Teacher’s 
Note:

Elucidate students that it is impossible to go through a day without the use of communication. 

Both the sender and receiver require a medium to communicate.

At the end of this chapter, students will be able to:

)) Know about computer network

)) Learn different types of networks

)) Identify the advantages of a computer network

Learning Outcomes

Warm-up

Circle the devices which are connected to Wi-Fi in your house.
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We frequently discuss our feelings, opinions, and favourite things with our friends . Similarly, 
two or more computers must be connected in order to share information. A computer 
network is made up of two or more computers that are connected to one another through 
various communication channels. These computers are all linked together in such a way 
that they can occasionally exchange data and hardware resources.

 The Need FOr A COmPUTer NeTWOrk

An organisation can benefit greatly from a computer network in a number of ways. Here are 
some advantages of a computer network.

Saves Cost

We have learned how all the computers are connected to a single network and can share a variety 
of hardware resources. There is no requirement to purchase several items as a result of this. For 
instance, a single modem can be used to link a variety of networked devices to the internet.

reducing data redundancy

Imagine that an organisation has 100 employees, and every single one of them wants to work 
on the same file. One approach is to keep separate copies of the same file on each computer. 
Data duplication or redundancy will result from this. The alternative is to connect all of the 
computers over a network and store a single copy of the file on a main computer, allowing 
the other networked computers to access the file as needed.

Sharing resources

Information or data, software 
applications, and hardware 
components make up resources. 
These resources can be shared 
across computers that are 
connected through a network. 

For instance, a single computer with 

Hey Friends! Let us 
learn about computer 
networks.

Figure 1.1: Sharing Resources
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a printer attached may exist in an organisation. All the other computers that are part of the 
network can use the network services of the same printer.

Security

As more computers communicate information via a network, security becomes increasingly 
important. This can be done using a variety of methods, including setting up a firewall 
system and other network protection tools that are available across many platforms. This 
aids in the fight against phishing and data theft.

 TyPeS OF NeTWOrkS

Computer networks can be characterised by their size as well as their purpose. There are 
different types of computer networks depending upon the number of devices that are 
connected together. 

The size of a network can be expressed by the geographic area they occupy and the number 
of computers that are part of the network. 

Personal Area Network (PAN)

A computer network set up just for an 
individual inside a compact building is 
known as a personal area network. This 
may take place in a small workplace or 
house. PAN generally covers a range of 
up to around 10 metres. A PAN would 
typically consist of one or more computers, 
phones, including mobile phones, printers, 
video game consoles, and other personal 
entertainment devices.

Local Area Network

The Local Area Network is confined to 
a limited area, such as a room, an office 
building, or a school, or a college campus. 
As the area covered by LAN is limited, the 
data transmission speed in LAN is very fast 

Figure 1.2: PAN

Figure 1.3: LAN

Do You Know?
The main role of PAN is to eliminate cables 
that connect devices to peripherals.
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and can be easily maintained. In LAN, wires are used to physically connect the computer 
terminals. WLAN refers to local area networks where computers communicate wirelessly.

metropolitan Area Network ( mAN)

A metropolitan area network consists of a computer network which covers an entire city, 
college campus or small region. As compared to LAN, it covers a wider area. A MAN 
network’s computers can be linked together using both wired and wireless communication 
methods. ATM machines of a specific bank, installed at different locations in a city, are an 
example of MAN.

Wide Area Network

A wide area network occupies a very large area, such as an entire country or the entire world. 
It consists of many smaller networks, such as LANs or MANs. The primary characteristic of 
WAN is that data transfer requires a public telecommunications medium. A very common 
example of WAN is the internet, wherein millions of computers are interconnected with 
each other.

 NeTWOrk TOPOLOgIeS

The organisation of diverse network components in a way that makes communication 
simple is known as network topology. Before you start with the arrangement of network 

Figure 1.4: MAN
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components, It’s crucial to establish the logical topology—also known as the information 
flow between network components. 

Network topologies are categorised into the following basic types:

Point-to-Point

This topology is among the most widely used since it is simple to utilise. Direct 

communication between two network components, such as PCs, routers, hubs, etc., is 

established using this method. Both wired and wireless technologies can be used to create 

a direct link.

Bus Topology

Bus topology, also known as line topology, 

is a type of network topology in which all 

devices in the network are connected by one 

central network cable or coaxial cable. The 

single cable, where all data is transmitted 

between devices, is referred to as the bus, 

backbone, or trunk.

There are two types of bus topologies:

�� Linear bus topology. All devices are connected to a single 

cable with two endpoints.

�� Distributed bus topology. All devices are connected to a 

single cable that branches off into multiple sections, resulting 

in more than two endpoints.

Star Topology

In a star topology, the central hub acts like 

a server and the connecting nodes act like 

clients. When the central node receives data 

from a connecting node, it can pass the 

data on to other nodes in the network. A 

star topology is 

also known as 

a star network.

In this topology, 

Figure 1.5: Bus Topology

A host on a bus network is 
called a station.

REMEMBER IT!

Figure 1.6: Star Topology

Let Me Answer
What do you mean by Star 
Topology?
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it is easy to add a new device to the network with the help of only one cable. The entire 

network goes down only if the central computer/hub fails.

ring Topology

Each computer in a ring 
topology is connected to 
the one behind it in such a 
way that when they are all 
put together, they resemble 
a shape of  ring. When one 
node sends a message to 
the other node, which is not 
adjacent to it, the data travels 
through all the intermediate 
nodes, until it reaches its final 
destination. The data in this 
topology has to pass through 
each connected computer; 
this makes it slower than the 
other topologies.

Tree Topology

A tree topology is a sort of 
structure in which each node 
is related to the others in a 
hierarchy. In a topological 
hierarchy, there are at 
least three distinct levels. 
Sometimes it is also called 
hierarchical topology as in 
this topology, all elements are 
arranged like the branches of 
a tree. In a tree topology, there 
can only be one connection 
between any two connected 

computers. For database-related services or to organise the 
computers in a large cooperative network, the tree topology 
is commonly utilised. In this topology, the expansion of 

Figure 1.7: Ring Topology

Figure 1.8: Tree Topology

Let Me Answer
How is Tree topology related to 
a tree?
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network is feasible, and an easy task to carry out, but the maintenance of the same is often 
difficult. 

mesh Topology

Computers are joined 
randomly in a mesh network 
structure. Each computer in 
the network can transmit a 
signal to the other computers 
in this sort of topology, and 
each computer also assists in 
retransmitting data to other 
computers in the network.
It is a topology commonly 
used for wireless networks. 
The cost is too high for maintaining this type of network. 

Peer-to-Peer Network

In the simplest terms, a peer-to-peer network is a network created whenever two or more 
devices (usually a computer) are connected and share resources available on the web. Each 
computer can act both as a server and a client as there is no central server in this network.

Figure 1.9: Mesh Topology

Figure 1.10: Peer-to-Peer Network
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Client-Server Network

Several Computers called clients are connected to the main computer called the server in 
this network. A computer that serves clients and manages access to hardware, software, and 
other resources is known as a server.The computers that ask the server for services like data 
retrieval, storage, etc. are known as clients.

Kids’ IQ
Shivani wishes to link the electronic devices of her entire family with each other. Give 
Shivani and her family a network type that will work for them.

Let’s Recall
•	 An organisation can benefit greatly from a computer network in a number of ways. 

•	 Computer networks can be characterised by their size as well as their purpose.

•	 A computer network set up just for an individual inside a compact building is 
known as a personal area network.

•	 A wide area network occupies a very large area, such as an entire country or the 
entire world.

•	 A tree topology is a sort of structure in which each node is related to the others in 
a hierarchy.

•	 In Client-Server Network, several Computers called clients are connected to the 
main computer called the server.

Figure 1.11: Client-Server Architecture
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Upskill Your Intelligence

A. Fill in the blanks.

 1. A single ............... can be used to link a variety of networked devices to the internet.

 2. Information or data, software application, and ............... components make up 
resources.

 3. Setting up firewall system aids in the fight against ............... and ................

 4. Computer networks can be characterised by their ............... as well as their ................

 5. The size of a network can be expressed by the ............................. area they occupy.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. A computer network setup just for an individual inside a compact  
building is known as wide area network. 

 2. PAN generally covers a range up to 10 metres. 

 3. The data transmission speed in LAN is very fast. 

 4. MAN stands for Metro Area Network. 

 5. Bus topology is also known as line topology. 

C.  Answer the following questions.

 1. Why is there a need for a computer network?

  ..............................................................................................................................................

  ..............................................................................................................................................

 2. Explain any two types of networks.

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. What do you mean by network topologies?

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. What is Client-server architecture?

  ..............................................................................................................................................

  ..............................................................................................................................................
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 5. Explain Wide area network. (WAN)

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Identify the following topologies.

   ........................................... ........................................... ...........................................

   ........................................... ........................................... ...........................................

Team Work

 Prepare a presentation on types of network.
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LOG ON TO ACCESS2

Teacher’s 
Note:

Guide students that it is very difficult to maintain this data manually when there are hundreds 

and thousands of records, as the chances of committing errors increase. Telephone directory, a 

dictionary, list of groceries in a grocery store are the examples of different types of databases.

At the end of this chapter, students will be able to:

)) Comprehend the concept of Database

)) Learn the advantages of DataBase Manager

)) Know the components of Access

)) Create a Database

)) Identify views in Access

)) Insert/delete field in Datasheet view

Learning Outcomes

Warm-up

Prepare a Telephone directory and address book of your friends.

Name Phone Number Address
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The use of data is essential in advanced technologies. Today’s most well-known apps and 
websites rely on data. Data is essential for organisations and institutions when creating 
strategy. Government also depends on data for decision-making and for creating favourable 
policies for the people of the country. The data needs 
to be stored in an organised way to allow for easy 
access and accurate information retrieval. Databases 
are used to organise the data in this manner.

 dATABASeS

A structured collection of information about an entity is what is meant by a database. 
Databases make it simple and efficient for users to add, access, modify, and delete data. 
A database may sometimes be regarded as a storage location for data. For example, an 
organisation can create its own database to store the personal records of their employees. 
The database system uses a hierarchical structure to store the data. A system that supports 
the organising of data is called Database Management System. (DBMS)

The way data is kept in a database is shown in the following diagram.

Database

Tables

Data

Hello Friends! Let’s 
learn how to arrange 
data in databases. 

Do You Know?
On November 13, 1992, the first version of 
MS Access was released by Microsoft.
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 AdvANTAgeS OF dATABASe mANAgemeNT SySTem

Control Of data redundancy

A computer’s memory is a crucial component. Memory is wasted as a result of redundancy. 
DBMS offers a number of methods to check for data redundancy.

Application Id Name Percentage School Allotted

23456 Shruti 79% DPS

23457 Shivani 78% APS

23456 Shruti 79% DPS

You can observe that the record of Shruti is entered twice. This may lead to wastage of 
memory.

maintaining data Consistency

Data consistency is the management of data across many database tables, particularly when 
the data in these tables is related to one another.

Table 1 Table 2

Application Id Name Application Id Percentage

23456 Shruti 23456 79%

23457 Shivani 23457 78%

23456 Shruti 23456 79%

Sharing of data

One computer’s data can be shared among numerous users with DBMS.

data Integrity

Data integrity guarantees that the database only contains relevant information. For Example, 
an organisation database should have data related to employees and clients.
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Figure 2.1: Components of Microsoft Access 2016

 WhAT IS mICrOSOFT ACCeSS?

Microsoft Access is the most popular and powerful RDBMS ( Relational Database 
Management System) that serves an integral part of the Microsoft Office Suite Application. 
It has a graphical user interface. It is employed to effectively organise and manage massive 
amounts of data. It organises data in the form of tables. Data duplication can be avoided 
with a relational database. Access also allows you to add, update, delete, and view data using 
forms. Further, it helps to find and retrieve the data in a desired way by using queries, and 
print the data in a specific layout by using reports.

Components of microsoft Access 2016

Let’s familiarise ourselves with the various parts of the Microsoft Access window.

Title Bar

The name of the current database is displayed on it, which is at the top of the window.

Quick Access Toolbar

This toolbar can be found in the Access window’s upper left corner. It has the command 
buttons that are used the most. It comes with three buttons by default: Save, Undo, and 
Redo.

Quick Access 

Toolbar

Work Area

Navigation 

Pane

Navigation 

Pane

Status Bar

Ribbon

View Buttons

Object Tab

Tabs Title Bar Tell me what you want to doQuick Access Toolbar
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ribbon

It has numerous tabs, each of which has a number of groups of relevant commands. Some 

tabs appear when you work with certain objects like Forms. Such tabs are called Contextual 

tabs.

Tell me What you want To do

It’s a brand-new tool that you may use to find quick information on subjects you’re interested 

in or commands you wish to utilise in your document.

Navigation Pane

This pane is present on the left side of the Access window. It displays the name of the Access 

components used in the database,e.g. Table, Forms, Queries, Reports, etc.

record Navigation Buttons

As the name suggests, it helps in navigating through the records. The navigation button 

displays the current record number in an object.

Object Tabs

The object tabs resemble the tabs found in web browsers. It displays the elements you’ve 

opened in tabbed form. The contents of the components in the Work area are displayed 

when you click on any tab.

Status Bar

This resembles the buttons we use in PowerPoint to select from 

the different views. On its extreme left, it displays the name of 

the current view and on its right, it displays four view buttons, 

which are Datasheet view, Design view, PivotTable view and 

PivotChart View, 

 CreATINg A dATABASe

Using a template or starting from a blank database are the two approaches to create a database 
in Microsoft Access. An access template helps in creating a complete data application which 
is ready to use. It contains four main objects like tables, queries, forms, reports,etc that you 
need to perform a specific task.

Let Me Answer
Can you tell which software is 
similar to Access 2016?
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Creating a Blank database

Follow the given steps to create a database from scratch.

Steps:

1. Click on the Blank database option.

2. Click on the Blank database option.

3. Click on the Blank database option.

Figure 2.2: Blank Database

Figure 2.3: Blank Desktop Database
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Creating a Table In design view

The Design view window’s structure can be seen in the following image.

Steps:

1. In the Field name, add a column name for the table.

2. Select an appropriate data type for the field from the Data Type drop-down list.

3. Add the text in the description to enter a few 
more details about the field.

4. Save the table by clicking on the Save option in 
the File tab.

Creating Table with datasheet view

Click the Create tab and choose the table button from the Tables group to create a table in 
the Datasheet view. This will create a new blank table. The table will open in the Datasheet 
view. 

Steps:

1. Click on the “Click to Add” label. Observe that the icon in the row selector changes to 
a pencil. This means that changes were made to the record but they weren’t saved. The 
asterisk (*) sign moves to the next row.

2. Enter the data. 

Figure 2.4: Creating Table in Design View

Access 2016 offers ready templates for 
regular users to create and publish data.

REMEMBER IT!
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3. Press the tab key after each entry

4. Click on the Save icon present on the Quick Access toolbar to save the table.

data Types In Access 

The following table depicts the available data types in Access 2016.

data Types Functions

Short Text It is used to store text or a combination of text and numbers. The 
fields with this data type can have a maximum of 255 characters.

Long Text It stores text and numbers up to 65,536 characters. It is used for 
descriptive fields.

Number It is stores numeric information that we can use for calculations. 
The maximum size of a number field can be 16 bytes. It can store 
both integer values as well as decimal values.

Date/Time It stores date and time values. The maximum size used by this data 
type is 8 bytes.

Currency This data type is used to store financial data up to 8 bytes.

Figure 2.5: Creating Table with Design View
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AutoNumber It generates a sequential number whenever a new record is added 
to a table. The value in the AutoNumber field cannot be changed. 
It stores data as 4-bytes.

Yes/No It is used at places where the field can have only one possible value. 
It can either be True/False, Yes/No.

OLE Object This is used to embed an object created in another application, such 
as Microsoft Word document, Excel spreadsheet, or PowerPoint 
presentation, into the Access table. It stores upto 2 GB of data.

Hyperlink The Hyperlink data type can store links to web pages, websites, 
files on an Intranet or LAN on your computer. It stores up to 1 GB 
of data.

Attachment The data type allows you to attach images, spreadsheet files, 
documents, charts, and other types of supported files to the 
records in your database.

Calculated This data type is used mostly in case of queries, forms, and tables 
that generate data from calculations performed on fields of a table.

Lookup Wizard A Lookup wizard helps you to create a field whose values are 
chosen from the values in another table, query or list of values. By 
default, Access sets Lookup fields to the Number data type.

 FIeLd PrOPerTIeS

A field property applies to a particular field in a table and defines the characteristics of that 
field. The field properties are used to define how a field can behave when data is added to 
the field. 

The following table shows a list of properties used in Access:

Field Property description

Field Size This property is used to specify the maximum size a Field can 
hold.

Format This property specifies the format of data a Field can hold. For 
example, there can be different formats for date and time.
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Input Mask It specifies the pattern for the data to be entered in a field. For 
example, you can choose the input mask for a password field as *.

Caption The Caption property specifies a column heading for a field. It 
is shown whenever a Field is displayed in Datasheet View. It can 
hold up to 2,046 characters.

Default Value The Default Value Property to specify a value that is automatically 
entered in a field when a new record is created. For example, 
Delhi can be a default value for the city field.

Validation Rule This sets a rule for a range of values that can be entered into a 
field. For example, marks>50; the marks field will only accept 
values greater than 50.

Required You can use this property to specify if a value is required in a 
field. It accepts two values, Yes and No. Yes, it means a value 
needs to enter, and No means it can be left blank.

 PrImAry key

Primary key is a standard feature of every database management 
system which is used to identify each record of a table uniquely. 
The field which is designated as the Primary key of a table 
neither can have duplicate data nor it can be left blank while 
entering the data.

Figure 2.6: Primary Key

Let Me Answer
Can we leave the primary key 
blank?
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Upskill Your Intelligence

A. Fill in the blanks.

 1. The use of data is essential in .................... technologies.

 2. Governments depend on data for .................... and for creating favourable policies 
for the people of the country.

 3. .................... are used to organise the data in an organised way.

 4. A database can sometimes be regarded as a .................... for data.

Follow the given steps to set the Primary Key.

Steps:

1. In the design view, click on the field you wish to set as the primary key.

2. The selected field will be highlighted.

3. On the toolbar, click on the Primary Key.

4. Save the table.

Kids’ IQ
Shobhit has been given an assignment to add a new table in the existing database. 
Which option should he use to complete the task?

Let’s Recall
•	 Microsoft Access is the most popular and powerful RDBMS ( Relational Database 

Management System) that serves an integral part of the Microsoft Office Suite 
Application.

•	 Data duplication can be avoided with a relational database. 

•	 ‘Tell me What You Want To Do’ is a brand-new tool that you may use to find quick 
information on subjects.

•	  The object tabs resemble the tabs found in web browsers.

•	 A field property applies to a particular field in a table and defines the characteristics 
of that field.
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 5. DBMS offer a number of .................... to check for data redundancy.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. A system that supports the organising of data is called Data Base  

Management system. 

 2. A computer’s memory is not necessarily important. 

 3. One computer’s data can be shared among numerous users with DBMS. 

 4. Data integrity guarantees that the database only contains irrelevant  

information. 

 5. Microsoft access is the most popular and powerful RDBMS. 

C.  Answer the following questions.

 1. What is Microsoft access?

  ..............................................................................................................................................

  ..............................................................................................................................................

 2. Describe the components of Microsoft Access 2016.

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. Write the steps to create a blank database.

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. How can we create a Table in Design view?

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. What do you mean by the Primary key?

  ..............................................................................................................................................

  ..............................................................................................................................................
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Critical Thinking

 Find out five components of microsoft Access.

W S U T A T S A T Y

D F G H J C K L O P

X T I T L E B A R N

A W E R E J T B Z J

A R I B S B D T X M

G R I B B O N C C K

N A V I G A T I O N

Team Work

 Team up with your lab partner and create the following table in a database named 

my grades.

Grades

�� English

�� Hindi

�� Maths

�� Social Science

�� Business

�� Maths

�� Science
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WORKING WITH QUERIES,  
FORMS AND REPORTS

3

Teacher’s 
Note:

Apprise students that forms help an individual or organisation to get detailed information about 

a person, event, or an object.

At the end of this chapter, students will be able to:

)) Learn the importance of Queries, forms and Reports in Access 2016.

)) Create forms, queries and reports in Access 2016.

Learning Outcomes

Warm-up

Fill the following Application form.

Customer Application Form
Name of Company

Street Address

Street Address

City

City

Region

Region

Postal / Zip Code

Postal / Zip Code

Country                                 

Country                                 

Full Postal Address *

Previous Full Postal Address

Details of Applicant



29 Computer-8

A form is a device for gathering data in a sequential style. Frequently, whoever creates the 
form has all the necessary fields for required data.

Forms actually make the process of entering data a lot convenient and simple. Forms make 
sure the proper data is entered into the table in the proper format.

We should be aware that the form is related to the table. This implies that the values entered 
into a form are kept in a table. Let’s learn to create forms in Access.The presence of an 
operational database and a table is one of the requirements for 
building a form in Access. If a database or table is not present, we 
can first construct one. Once our database and tables are available, 
you can create a form by following the instructions below.

Steps:

1. From the Navigation Pane, choose the table.

2. Click the Form button in the Forms group after selecting the Create tab from the ribbon.

Hello Friends! Let us 
learn to create Forms, 
Queries and Reports.

Figure 3.1: Navigation Pane

Let Me Answer
Have you ever filled in any 
form?
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3. A new form has been created; notice how the ribbon’s options have changed and how 
the Design tab is now active.

4. Click the Home tab and then the view button displayed in the Views group to input or 
edit records in the form. Go to the drop-down menu and choose Form View.

Update the value, then press the Enter key to modify it. Open the form table using the 
Navigation pane and look for any changes to see whether the value has changed.

Figure 3.2: Design Tab

Figure 3.3: Form View
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 reCOrd NAvIgATION BAr

A form’s record navigation bar is a crucial component. It facilitates the form’s navigation 
and value modification. Let’s quickly comprehend how this bar functions.

 FOrmATTINg A FOrm

Changing Themes and Fonts of a Form

Follow the given steps to change the theme of a form.

Steps:

1. In the Navigation pane, click the name of the form. Launch the Layout View and open 
the form.

2. Click on the  button in the Themes group. We can choose the theme we want from 
the drop-down list. By selecting the Colours and Fonts button found in the Themes 
group, we can also alter the theme’s colours and font.

Figure 3.4: Applying Themes and Fonts

Displays the 

previous record

Displays the first 
record

Displays current 

record

Displays the last 

record

Displays the next 

record

Enter a New 

Record

Search for a 

specific record
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Inserting date and Time to a Form

Follow the given steps to insert Date/Time to the Form.

Steps:

1. In the Layout view, open the form.

2. Select the Date and Time option in the Header/Footer 
group.

3. Choose the preferred date and time format from the 
Date and Time dialogue box.

4. Click on the OK button to insert date and time.

Arranging the Order of the Fields in the Form

Click the Arrange tab in the MS Access ribbon to reorder the text fields of the form.

  

To reorder the text fields in a form, use the set of options found under the Arrange tab.

Adding Background Image to a Form

Follow the given steps to add a 
background image to a Form.

Steps:

1. In the layout view, open the 
form.

2. Select the Background 
Image option by clicking 
the Format Tab.

3. Select Browse. The dialogue 
window for inserting a 
picture will display.

Figure 3.5: Arrange Tab

Figure 3.6: Inserting Picture

Do You Know?
Anchoring is a cool feature which 
gives your form a professional look.

PIC

date and time



33 Computer-8

4. Click the open button after choosing the image you wish to use as a background image.

 SAvINg A FOrm

Follow the given steps to save a form.

Steps:

1. Click on the Save Button in the 
Quick Access Toolbar to save a 
form.

2. In the Save As dialogue box, type 
the name in the Form Name text 
field and click on OK.

 QUery IN ACCeSS 2016

In simple terms, a query is a simple question that you ask to find specific information from 
the database. Similarly, in Access, when you build a query, you are defining specific search 
conditions. You can use queries to view, change, summarise and analyse the specific data in 
different ways. 

Queries are made on tables and the results are displayed in the forms of a table,which are 
composed of rows and columns and include the data that satisfy the criteria.In other words, 
a query is like a question you ask from a database, and the database in reply returns  the 
required records you have requested.

Figure 3.7: Form Background Image
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In Access, a query can be created in two different ways.

1. Using Query Design

2. Using Query Wizard

You can have more control over a query with the design view. 
You can build a query from scratch with it.

Steps

1. On the ribbon, select the Create tab. Then, in the Queries group, click the Query Design 
button.

2. The dialogue box for the show table will appear. Choose a table from the list of tables 
for your query. Depending on our needs, we can choose a single table or a number of 
tables.

Figure 3.8: Show Tables

Let Me Answer
Does a sudden question appear on your 
screen when you enter a website, sometimes?

A query gives the user a custom 
view of the data.

REMEMBER IT!

Query: Get me the records of 

all the patients suffering from 
heart problem.

Database: Here are the 

records you need.
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Figure 3.9: Query Design Window

Figure 3.10: Query Design Window

3. Click the Add button after choosing a query table from the Show Table dialogue box. 
You’ll see the screen given below.

4. See how the Object Relationship Pane displays the fields from the selected tables.

5. A query is made up of one or more table fields. Drag and drop the fields to the field 
property to add them to the query in the Query Design Grid as shown below.

Field Property

Object Relationship Pane

Query Design Grid
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6. When your query is ready, click the Run button in the Results group on the Design tab 
to see the query’s results. The query’s outcome will be displayed in the output window, 
as seen below.

 CreATINg QUery WITh QUery WIzArd

A small built-in application called Wizard asks users questions and then displays a result 
based on their inputs.

Steps:

1. Select the “create” tab. In the queries group, click the Query wizard button.

Figure 3.11: Query Design Grid

Figure 3.12: Query Result

Figure 3.13: Create Tab
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2. The New Query dialogue box appears. By default, the Simple Query Wizard option is 
chosen. Click OK to continue.

3. As illustrated below, the wizard will now ask us to choose the query table and the fields 
inside it that we want to include in the query.

4. We will be asked to enter the query title in this final step. Additionally, we have the 
choice of the following two possibilities.

�� Open the query to view information.

�� Modify the query design.

�� Open the query to view the result of the query.

�� Select the second option if you wish to modify the query.

5. Click the finish button after selecting the first choice.

Figure 3.14: New Query

Figure 3.15: Selecting Fields Figure 3.16: Adding Fields
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 rePOrTS IN ACCeSS 2016

For viewing or printing, a report is a useful tool for organising and summarising data. A 
report can be created exactly the same as we have created the form. The only modification 
is that you now click on Report in the Reports group after choosing the Create Tab.

Let’s learn to create reports in Access.

Steps:

1. After selecting the Create tab on the ribbon, go to the Reports group and select the 
Report button.

2. The Report Layout window displays a new report; notice how the ribbon’s options have 
changed and how the four new tabs Design, Arrange, Format, and Page Setup have 
been added to the ribbon.

 SAvINg A rePOrT

Follow the given steps to save a Report.

Steps:

1. Click on the Save button in the 
Quick Access toolbar to save a 
report.

2. Type the desired form name in the 
Save As dialogue box in the Report 
Name text field and click on Ok.

Figure 3.17: Report Layout Window
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Kids’ IQ
Fifty records have been added to a database that Sanisha established of her classmates. 
She must display the statistics for the kids who received less than a 35% grade, per the 
teacher’s request. Give her some advice on how to apply this standard.

Let’s Recall
•	 A form is a device for gathering data in a sequential style.

•	 The presence of an operational database and a table is one of the requirements for 
building a form in Access.

•	 A query is a simple question that you ask to find specific information from the 
database. 

•	 A small built-in application called Wizard asks users questions and then displays a 
result based on their inputs.

•	 A report is a useful tool for organising and summarising data which can be created 
exactly the same as we have created the form.

Upskill Your Intelligence

A. Fill in the blanks

 1. A form is a device for gathering data in a .................... style.

 2. The .................... is related to the table.

 3. The presence of an .................... database and a table is one of the requirements for 
building a form in Access.

 4. Choose the table from .................... pane.

 5. .................... facilitates the form’s navigation and value modifications.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. The Arrange tab reorders the text fields of the form. 

 2. Save button is present on the File tab. 

 3. A query is a simple question that you ask to find specific information  
from a database. 
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 4. Queries are made on documents. 

 5. A report is a useful tool for organising and summarising data. 

C.  Answer the following questions.

 1. What is a form?

  ..............................................................................................................................................

  ..............................................................................................................................................

 2. In what way can you format a form?

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. Write the steps to create a form.

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. How can we create a query using the query wizard?

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. What do you mean by reports in Access 2016?

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Amazon has a huge database of employees and clients. The company wants to maintain 
the privacy of each employee and client. They have given the instructions to computer 
operators to update each record, one at a time.

 Which database object should it use to perform this task?

Team Work

 Conduct a group discussion on the following topic:

 Creating Query using The Query Wizard v/s Creating Query using The Query Design.
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CLOUD COMPUTING4

Teacher’s 
Note:

Ask students how these clouds are somehow useful to us, how they help us. Also introduce them 

with the term ‘ Cloud Computing’.

At the end of this chapter, students will be able to:

)) Learn the pros and cons of Cloud Computing.

)) Know about different types of clouds services.

)) Understand different types of services a cloud can offer.

Learning Outcomes

Warm-up

Observe the following picture and write five things that come to your mind.

1. ......................................................................................................................................................

2. ......................................................................................................................................................

3. ......................................................................................................................................................

4. ......................................................................................................................................................

5. ......................................................................................................................................................
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Cloud computing is a service that requires a subscription and includes a number of services. 

These services are used by individuals and organisations. Because all of the processes take 

place in the internet world, it is known as cloud computing.

Today, cloud computing is attracting a lot of interest from consumers, including everyone 

from individuals at home to the government. One approach to understanding cloud 

computing is to think about how we use our email account.We launch a web browser and 

sign into our email account to view our email when we need to. Our email accounts aren’t 

kept in the computer’s memory, but we can access them 

from anyplace with an internet connection. Our emails 

are kept in a server computer that is physically situated 

far away. Our email account can be accessed via  email 

server through  internet connectivity.

The functioning of an email service is comparable to cloud computing. If we use a cloud 

service, we can access a variety of user-available services like storage, processing, and 

security services in addition to accessing our email.

 AdvANTAgeS OF USINg CLOUd ServICeS

You can become an expert in machine learning if you comprehend other concepts that are 
related to it. The various fields that have contributed to machine learning are briefly listed 
below.

Freedom of Access

The drawback of the conventional computer system is that we must physically present where 
our data storage device is in order to access it.Through the internet, we can access data using 
cloud services from anywhere in the world.

helpful for Businesses

Small businesses can benefit from cloud services. However, they provide a significant 
contribution to small businesses by providing them with storage and processing capabilities, 

Hello Friends! Let’s learn about 
Cloud Computing.

Do You Know?
By 2023, researchers predict that more 
than 40 zettabytes of data will be stored 
on the cloud.
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which were previously only accessible to large organisations because of the high cost of 
infrastructure construction.

Flexible Services

Sometimes, a business or a person may need more or less space depending on their storage 
space needs. We can also quickly sign up for or discontinue using a cloud service.

reduction in Cost

If someone wants to launch a 
new business, they will need 
to invest a lot of money in new 
computers, internet access 
devices, additional storage 
devices, security measures, and 
software licences.This would 
undoubtedly take a large amount 
of money. By using cloud 
services that can meet all of our 
needs for storage, security, and 
app accessibility, we can reduce 
this expense. The setup cost will 
be significantly reduced by using 
cloud services.

Cloud Storage

The majority of cloud providers 
offer storage options. Users love 
these storage services extremely much. Google Drive, Dropbox, One Drive, and other well-
known services are very popular. As a result, it is crucial for us to comprehend the security 
procedures that a cloud service provider has in place and to take our own steps to protect 
our data.

 TyPeS OF CLOUd ServICeS

Different types of cloud services are available depending on the needs of the users. 

Public Cloud

Anyone with an internet connection and access to the cloud space can use the public cloud. 
All of its users have access to the public cloud. It is accessible to everyone, but the data and 
applications used by one subscriber are hidden from all other subscribers.

Figure 4.1: Cloud Computing
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Figure 4.2: Cloud Computing

Let Me Answer
Discuss about icloud service 
provided on Apple phones.

Private Cloud

A private cloud is created specifically for a given organisation, and only that organisation is 

permitted to use or access it. Access to data and applications is strictly controlled in private 

clouds. An example of this may be a school’s canteen, which is solely open for its own 

faculty, students, and staff.

Community Cloud

A community cloud is shared by two or more businesses with 

similar cloud needs. This kind of solution aids businesses in 

cutting costs associated with cloud services.

hybrid Cloud

In core, a hybrid cloud is the merging of at least two clouds, where the clouds are a mix of 

community, private, and public clouds.

 TyPeS OF ServICeS PrOvIded IN CLOUd

Software as a Service

A SaaS cloud service gives subscribers access to different applications (apps). SaaS frees us 
from downloading and storing an app in our phone, this means you do not need to install 
the required app on your devices. SaaS makes it easier to have the same software on all the 
devices at once by accessing it on the cloud.

Provisioned 

for open use 

for the public 

by a particular 

organisation who 

also hosts the 

service.

Used for a single 

organization; can 

be internally or 

externally hosted.

The composition of 

two or more clouds 

(private, community 

or public) that 

remain unique 

entities.

Shared by several 

organisations; 

typically externally 

hosted, but also 

can be internally 

hosted by any 

organisation.

COmmUNITyhyBrIdPrIvATePUBLIC
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Platform as a Service

A PaaS system goes a level above the Software as a Service setup. A PaaS provider gives 

subscribers access to the components required to develop and operate applications over the 

internet.

Infrastructure as a Service

In an IaaS agreement, the subscriber completely outsources the storage and resources, such 

as hardware and software, that they need.

All this simply means that we can choose a specific cloud service based on our requirement.

 CLOUd SeCUrITy

We all recognise the need of protecting 

our data from unauthorised users. By 

incorporating system security in the form of 

a user ID, password, or pin, we may protect 

the data on our computer. However, if we 

are using the internet to store our data on a 

cloud service, it may also free up more space 

for other users to access our data.

However, we will have to willingly lose direct 

control of our data in order to benefit from 

the cloud. On the contrary, keep in mind that 

most cloud service providers have a great 

deal of knowledge on how to keep our data 

safe. In order to secure their computers and 

networks, service providers have access to more tools and knowledge than the average user.

The following considerations should be made by a user before choosing which cloud services 

to use.

�� What kind of encryption does the provider use?

�� What methods of protection do they have in place for the actual hardware that our data 

will be stored on?

�� Do they have duplicates of our data on hand?

Figure 4.3: Cloud Security
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�� Do they have firewalls set up?

�� What safeguards are in place to prevent a user’s information from being shared with 

other users if they have a community cloud?

 dISAdvANTAge OF CLOUd COmPUTINg

�� We have little to no understanding of where our data is stored, and we have limited 

control over who has access to our information.

�� Our data is frequently accessed by hackers without our permission.

 SOme POPULAr CLOUd ServICeS

dropbox

One of the best cloud services for sharing files is Dropbox. It offers 

its customers SaaS-based services. Many people take advantage of 

its limited free storage options, but it also provides paid services 

to both individuals and organisations under various plans.

google gSuite

The most widely used email application in the Google Play Store 

is Gmail, a free online email service. Google Calendar, Google 

Drive, Google +, Hangouts, Docs, Sheets, Forms, Slides, Sites, 

Keep, and Jamboard are all part of Gmail’s email service. It also 

provides cloud-based storage services to the users.

Adobe Creative Cloud

Creative professions like artists, filmmakers, designers, and other creative professionals 

can access cloud-based services from Adobe Creative Cloud. InDesign, XD, Premiere Pro, 

Dreamweaver, etc. are a few of the most well-known apps.

Kids’ IQ
What kind of cloud service should your school institution choose, and why, if it is 
required to do so?

Let Me Answer
Do you have a gmail account?
Google drive.

1.2 billions files are saved on 
Dropbox every day.

REMEMBER IT!
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Upskill Your Intelligence

A. Fill in the blanks.

 1. Cloud computing is a service that requires a .....................

 2. The functioning of an .................... service is comparable to cloud computing. 

 3. .................... businesses can benefit from cloud services.

 4. The majority of cloud providers offer .................... options.

 5. A .................... is created specifically for a given organisation, and only that 

organisation is permitted to use or access it.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. One of the best cloud services for sharing files is Dropbox.  

 2. The most widely used email application in the Google Play Store is Yahoo. 

 3.  A hybrid cloud is the merging of at least two clouds, where the clouds are 
 a mix of community, private, and public clouds. 

 4. Access to data and applications is uncontrolled in private clouds. 

 5. A community cloud is shared by two or more businesses with similar  
cloud needs. 

Let’s Recall
•	 Cloud computing is a service that requires a subscription and includes a number 

of services.

•	 If we use a cloud service, we can access a variety of user-available services like 
storage, processing, and security services in addition to accessing our email.

•	 One of the best cloud services for sharing files is Dropbox.

•	 Creative professions like artists, filmmakers, designers, and other creative 
professionals can access cloud-based services from Adobe Creative Cloud.

•	 A private cloud is created specifically for a given organisation, and only that 
organisation is permitted to use or access it.
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C.  Answer the following questions.

 1. What is cloud computing?

  ..............................................................................................................................................

  ..............................................................................................................................................

 2. What are the types of cloud services?

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. Write two disadvantages of cloud computing.

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. What considerations are to be made before choosing cloud service?

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. Write about any two cloud services. 

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Samaira prefers to use a cloud-based service that will provide her access to various 
Office-based programmes rather than installing Microsoft Office on her laptop. 

 Name the service you think Samaira should use.

Team Work

 Together with your pals, make a video outlining the benefits and drawbacks of 

cloud computing. Use your teacher’s assistance to show the video to each of your 

classmates.
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INTRODUCTION TO ARDUINO5

Teacher’s 
Note:

Guide students that as our sense organs are capable of performing multiple tasks, a microcontroller 

is a small computer chip mounted on a single integrated circuit that is capable of performing 

multiple operations like input, processing and output.

At the end of this chapter, students will be able to:

)) Learn about Arduino.

)) Know various parts of the Arduino board.

)) Write code in Arduino IDE.

Learning Outcomes

Warm-up

Look at the following picture carefully. Identify and write about the functions.

1.  ...................................................................

  ...................................................................

2.  ...................................................................

  ...................................................................

3.  ...................................................................

  ...................................................................

4.  ...................................................................

  ...................................................................

5.  ...................................................................

  ...................................................................
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Hello Friends! Let’s Know 
about Arduino

 ArdUINO

Arduino is a tiny computer chip installed on a 

single integrated circuit, it is a reasonably priced 

microcontroller. It has a processor, memory, and 

programmable input/output peripherals. It is 

capable of performing multiple operations like input, 

processing and output.

The majority of the computers we are acquainted with accept 

human input via a keyboard and mouse. The many sensors that are 

attached to an Arduino allow it to sense light, sound, vibrations, 

temperature, and other things as well as receive input from the 

user. These measurements can subsequently be transformed into digital signals by the 

microcontroller.

Humans use their senses to perceive their surroundings. Similar to this, if we combine 

several sensors with a microcontroller, these sensors can scan the area around us and relay 

inputs to the memory for processing. The result can then be seen on the screen.

Figure 5.1: Arduino and its Sensors

Let Me Answer
How can a robot sense its 
environment?

Do You Know?
Arduino was initially intended to serve as a 
teaching tool that would introduce students 
to the world of electronics.
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 PArTS OF AN ArdUINO

1.  Built-In Led

Whether your Arduino is delivering or receiving data is indicated by the LEDs labelled TX 

and RX. 

2.  On Indicator Led

When the LED is turned on, this shows that it is receiving electricity.

3.  digital I/O Pins

The holes on this side of the board are called the digital input/ output pins. They are either 

used to sense the outside world (input) or control lights, sounds or motors. (output)

Figure 5.2: Parts of an Ardunio Board

1. 3.

7.6.

2.

4.

build-in-LEDs Input and Output pins

Analog pinsPower and ground pins

On indicator 

LED

Voltage 

regulator

Power 

port

TX/RX Pins

Reset button

USB port
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4.  TX/rX Pins

Special pins with the labels TX and RX are PIN 1 and Pin 13. You should always leave these 

pins empty. Anything wired into Pin 0 prevents your software from loading any changes 

you make.

5.  ATmega328P, Black Chip

An ATmega328P is the black chip in the centre of the circuit board. This is the brain of the 

Arduino. It interprets the programming code that you submit to your Arduino as well as the 

inputs and outputs.

6.  Power and ground Pins

Here are the power-related pins. These pins can be used to connect the Arduino to 

the breadboard circuit’s power supply. These pins capture a range of values of sensor 

readings.

7.  Analog Pins

Instead of providing a simple on/off signal, these pins take sensor measurements throughout 

a range of values.

 CONNeCTINg yOUr COmPUTer TO ArdUINO BOArd

Following steps indicate how we can connect the Arduino to the computer.

Selecting right Components

An Arduino, a computer, and a USB A-B cable are required.

Plug-in USB Cable

Start by inserting the USB cable into a computer’s USB port as demonstrated below. Connect 

the USB cord to the Arduino’s USB port.

Figure 5.4: Arduino USB Port
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See the Arduino’s top view of the USB port with the USB A-B cable

 ArdUINO Ide

With all the features one would require, the Arduino team has created an IDE for use with 

their devices.

It includes a tool called a code editor that can be used to write any kind of code.With the aid 

of a message box that displays code faults and a console that provides further information 

about the nature of these mistakes, the code can be tested in the IDE and utilised to address 

any emergent problems. It has buttons for checking the code, saving it, uploading it to 

Arduino, and other functions.

Figure 5.5: USB Port Top View

Figure 5.6: Arduino IDE

Menu

Standard Toolbar

Code Editor Window
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REMEMBER IT!

In 2014, more than 240 user groups, Makerspaces, hackerspaces, fab labs, schools, studios and educators 
throughout Europe, North and South America, Asia, Africa and Australia came together to celebrate the 
inaugural Arduino Day.

 WrITINg yOUr FIrST PrOgrAm

Now let’s use the Arduino IDE to write some code. Code for Arduino can be written in a 

variety of languages, including Java, C++, and Python. Since we know Python, we will write 

our code in Python.

To connect Python and Arduino, follow the instructions.

Steps:

1. Open Arduino IDE.

2. Click on File> Examples>Firmata> StandardFirmata

3. To load the Firmata support files to the Arduino Board, click the tick button now.

4. The pyFirmata library needs to be downloaded to Python . This makes it easier for us 
to write code in python for Arduino.

Figure 5.7: Selecting StandardFirmata Library
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5. Enter “Command prompt” in the search box, then select “Run as administrator.”

6. In the Command prompt window, type the command pip install pyfirmata and press 
the Enter Key. The downloading process will begin after this.

Figure 5.9: Installing Pyfirmata

Figure 5.8: Opening Command Prompt
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7. Now open the Python IDE and write the code given below.

 

8. After pressing F5 to run the code, you should observe the LED on pin 13 begin to 
blink.

Kids’ IQ
Search about a microcontroller chip. Talk about it in the class.

Let’s Recall
•	 Arduino is a tiny computer chip installed on a single integrated circuit.

•	 It is capable of performing multiple operations like input, processing and output.

•	 The many sensors that are attached to an Arduino allow it to sense light, sound, 
vibrations, temperature, and other things as well as receive input from the user. 

•	 Microtellers can then convert these measurements into digital signals.

•	 Different languages can be used for writing code for Arduino like Java, C, C++, and 
Python.

Figure 5.10: LED Code
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Upskill Your Intelligence

A. Fill in the blanks.

 1. Arduino is a tiny computer chip installed on a single .....................

 2. The many sensors that are attached to an Arduino allow it to sense and receive 
.................... from the user.

 3. if we combine several sensors with a ...................., these sensors can scan the area 
around us.

 4.  Microtellers can convert measurements into .................... signals.

 5.  Arduino includes a tool called a .................... that can be used to write any kind of 
code.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. The black chip in the middle of the board is an ATmega328P. 

 2. Pyfirmata is required to establish communication between Python  
and Arduino. 

 3. Analog Pins take sensor measurements throughout a range of values. 

 4.  You cannot write code in the Arduino IDE. 

 5.  Arduino IDE has an in-built code editor. 

C.  Answer the following questions.

 1. What is a microcontroller?

  ..............................................................................................................................................

  ..............................................................................................................................................

 2. Briefly explain any two parts of Arduino.

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. What are Analog Pins?

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. What is the importance of IDE?

  ..............................................................................................................................................

  ..............................................................................................................................................
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 5. Differentiate between an Arduino and a normal computer.

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Label the Arduino board shown below.

Team Work

 Team up with your partner and create a program in python that will blink Led 8 

and 9.

1. 3.

7.6.

2.

4.

Voltage 

regulator

Power 

port

Reset button

USB port
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LOOPING STATEMENTS IN PYTHON6

Teacher’s 
Note:

Guide students about the loop game.  Introduce them with the loop statements in Python, what if 

something has to be printed 100 times. You need to type 100 times which seems time-consuming. 

So, this is where the loops play a very important role.

At the end of this chapter, students will be able to:

)) Comprehend Looping statements in Python.

)) Traverse elements using loops.

)) Know the working of the range function.

)) Know the operations of for and while loops.

Learning Outcomes

Warm-up

Play the game.

Start here! I have 25 I have 38 I have 18

I need 5 × 5 I need 26 + 12 I need 6 × 3 I need 44 + 11

I have 55 I have 28 I have 65 I have 36

I need 7 × 4 I need 41 + 24 I need 9 × 4 I need 32 + 12
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Hello Friends! Let’s learn 
about the looping statement 
in Python.

The idea of a loop enables us to execute programme instructions repeatedly without 
having to repeatedly write the same ones.The successful execution of loop depends on the 
condition. As long as the condition returns True, the statements continue to run.The loop 
ends automatically when the condition returns False.

For Example, Mother gives you a bowl of rice. You won’t eat it up at once. You start with 
the first spoon, then second and so on. In this manner, you finish your rice after several 
tablespoons of eating. (let’s say eight) 

Let’s examine the programming-based loop example.

Let the control variable be A. In this example, we have taken the initial value of A as 0. 
When you eat the first spoon, the value of A  becomes 1, after the second spoon, its value 
becomes A = A + 1 i.e., 1 + 1 = 2 and so on. The value increases every time the process 
repeats. After being increased, the control variable C will be evaluated to the maximum 
number of repetitions, which is 8 rounds.

Start

Stop

Let A = 0

A = A + 1

(Take more rounds)

Are the number 

of time you eat 

greater than or 

equal to  

8 (A>=8)?

No

Yes

Take start eating as A
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It will keep going till the value of A equals 8. This indicates that the loop will repeat itself 
eight times before coming to an end.

Do You Know?
The use of loops in programming has the benefit of reducing both the number of instructions and the amount 
of memory required.

Python uses loops to iterate through sequence elements. Two different types of loops are 
available in Python for use in looping operations.

�� For loop

�� While loop

 FOr LOOP

The for loop is used to repeatedly iterate over a sequence’s values. These values can be either 
string, list or tuple values. 

The control variable determines whether each value in the sequence has been traversed or 
not with each iteration.Traversal is the process of accessing elements in a sequence one at 
a time.The for loop’s body is no longer performed once all the values in the sequence have 
been traversed; instead, control is passed to the statements that come next.The for loop 
statement is used when you know the number of iterations beforehand.

Let me answer: How would you define a loop?

The ‘for loop’ is also called a counting loop.

Program: Printing the characters of a string.

   For letter in ‘APPLES’:

    Print (‘Current Letter’ : letter)

 

Output



62Computer-8

Program: Printing the items of a list.

   SDGS = (‘ Women Empowerment’ , ‘Girl’s Education’, ‘Gender Equality’)

   for goal in SDGs:

    print (‘Current goal:’, goal)

 LOOP CONTrOL STATemeNTS

There are three loop control statements in Python. These are used to alter how the loop 
typically operates.

Break Statements

The break statement ends the loop statement and shifts control to the statement that comes 
right after the loop.

Program: Using break statement

   SDGS = (‘ Women Empowerment’ , ‘Girl’s Education’, ‘Gender Equality’)

   for goal in SDGS:

    if goal == “Women Empowerment”:

     print (goal)

     break

This will print only ‘Women Empowerment’ and stop the execution of the loop although 
more items are present in the list.

Output
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Continue Statement

This command causes the loop to skip the remaining portions of its body and to retest its 
condition right away before updating the loop variable.

Program: Using continue statement to not print ‘Women Empowerment’

   SDGS = (‘ Women Empowerment’ , ‘Girl’s Education’, ‘Gender Equality’)

   for goal in SDGs:

    If goal ==’Women Empowerment’

     continue

     print (goal)

This will print the other items of the list except ‘Women Empowerment’.

Output

Output
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Pass statements

Pass statements are used to create empty loops.

 INFINITe LOOP

If a condition never evaluates to FALSE, a loop becomes infinite. It occurs because the loop 
either lacks a terminating condition or has a requirement that can never be satisfied. As a 
result, a never-ending cycle is created. It is known as an infinite loop.

Program: Write a program to display an endless loop.

   var= 1

   While var == 1:

    num = int(input(“Enter a number :”))

    print (“You entered: “, num)

 WhILe LOOP

In the while loop, if the specified condition is true, a series of statements will be carried out 
. Prior to starting the body of the loop, the condition is tested. One statement or a group of 

Empty loop

Output
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statements could be found in the loop body. The statement that comes straight after the loop 
receives control when the condition is changed to false. It’s referred to as a conditional loop.

 Syntax:

 while expression:

 statement(s)

The body of the loop is skipped and the statement that comes after it is performed if the 
condition is first found to be false.

Program: Write a program to print all the numbers up to the number entered by the user.

   n = int(input  (‘Enter a number:’))

   while (n > 0):

    print (n)

    n = n - 1

The user is prompted to input a number in this section. The condition is checked first, 
then the number is entered. Since 4 was entered , the condition is true, and so 4 is printed 
according to the first statement inside the loop body. 

The value of n is then decreased by 1, making it 3 (i.e. 4-1). The operation is repeated after 
returning to the loop’s first statement to check the condition. As a result, the loop runs four 
times until the value of n equals 0, at which point the condition will be considered false. 
After the while loop, control will move to the statement.

Kids’ IQ
Write a program to print the odd numbers between 1 and 30.

Let’s Recall
•	 The idea of a loop enables us to execute programme instructions repeatedly without 

having to repeatedly write the same ones.

•	 The ‘for loop’ is also called a counting loop.

•	 The break statement ends the loop statement and shifts control to the statement 
that comes right after the loop.

•	 In the while loop, if the specified condition is true, a series of statements will be 
carried out .

•	 If a condition never evaluates to FALSE, a loop becomes infinite.

Python groups statements using identification 
as a grouping strategy.

REMEMBER IT!
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Upskill Your Intelligence

A. Fill in the blanks.

 1. The successful execution of the loop depends on the .........................

 2.  There are ........................ loop control statements in Python.

 3.  ........................ is the process of accessing elements in a sequence one at a time.

 4. If a condition never evaluates to FALSE, a loop becomes .........................

 5. ........................ command causes the loop to skip the remaining portions of its body 

and to retest its condition right away before updating the loop variable.

B. Answer in one word.

 1. A loop that tests the condition before executing the loop body.

  ..............................................................................................................................................

 2. It is also called a conditional loop.

  ..............................................................................................................................................

 3. Accessing the elements of the loop one by one.

  ..............................................................................................................................................

 4. It is also called a counting loop.

  ..............................................................................................................................................

 5. This statement ends the loop statement and shifts control to the statement that 

comes right after the loop.

  ..............................................................................................................................................

C.  Answer the following questions.

 1. What are loops? Give real life examples.

  ..............................................................................................................................................

  ..............................................................................................................................................
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 2. What is an infinite loop?

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. State the difference between for loop and while loop.

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. Write a program to print all the numbers up to the number entered by the user.

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. What do you mean by continue statement?

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Is an infinite loop useful? Think and write.

 ......................................................................................................................................................

 ......................................................................................................................................................

 ......................................................................................................................................................

 ......................................................................................................................................................

 ......................................................................................................................................................

Team Work

 Team up with your partner and write a program to find if the given number entered 

by the user is even or odd.
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ROBOTICS7

Teacher’s 
Note:

Apprise students that to answer the above question, they had to think a bit. In the same way, 

when a machine thinks and decides independently it makes it artificially intelligent.

At the end of this chapter, students will be able to:

)) Know about Robotics.

)) Learn the composition of Robots.

)) Recognise the characteristics of a Robot.

)) Understand the types of Robots.

)) Comprehend the uses of Robots.

Learning Outcomes

Warm-up

Think about the following questions and write the answers.

Q1. What is your plan for the coming weekend?

 ......................................................................................................................................................

 ......................................................................................................................................................

 ......................................................................................................................................................

Q2. What did you do when you woke up today?

 ......................................................................................................................................................

 ......................................................................................................................................................

 ......................................................................................................................................................

Q3. What will you play after going home?

 ......................................................................................................................................................

 ......................................................................................................................................................

 ......................................................................................................................................................
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Hello Friends! You all know about 
Artificial Intelligence. Let’s learn 
about one of the latest technologies 
of AI i.e. Robotics.

 rOBOTICS

The study of building effective and intelligent robots is the focus 
of the artificial intelligence field of robotics.

Robots are artificial agents that behave in the real world. They 
can carry out the tasks that a person gives them. Robots are 
equipped with sensors that can recognise and pick up on 
physical information from the outside world, such as heat, 
light, temperature, pressure, sound, bumps, and movement.
To demonstrate intelligence, they have several sensors, a large 
amount of  memory, and powerful Processor cores. Additionally, 
they have the capacity to grow from their mistakes and mould 
themselves to the new surroundings. Electrical engineering, 
mechanical engineering, and 
computer science are combined 
in robotics to design, build, and 
use robots.

 COmPOSITION OF rOBOTS

Robotics uses computer science, mechanical engineering, and electrical engineering to 
build, develop, and use robots.

�� Robots’ mechanical designs develop shapes or their forms to do a specific task.

�� Electrical components power and regulate the machinery of robots.

�� Robots operate under the control of some sort 
of computer software that dictates what, when, 
and how they perform things.

Robots are developed with:

�� Actuator used in Robots convert energy into movement.

Figure 7.1: A Robot

Let Me Answer
Have you ever seen a Robot?

Do You Know?
The term ‘robot’ comes from the Czech 
word ‘Robota’, that means ‘Drudgery’ or 
‘hard work’ and ‘forced lab
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�� Electric motors are required for rotational movement.

�� Batteries, solar power, hydraulic or pneumatic power sources.

�� Muscle wires contract by 5 % when electric current is passed through them.

�� Sensors provide knowledge of real time information on the task environment.

 FeATUreS OF A rOBOT

Robots resemble humans in terms of their physical composition. They are held together by 

a structure, and they can move due to mechanical components. A robot is capable of doing 

actions and movement.

�� A robot absorbs information about its surroundings and makes use of that data to 

carry out tasks as directed.

�� It functions according to the programs installed in it and the programs can be changed 

accordingly.

�� Robots have sensors which enable them to 

see even in dark as well as detect the small 

movements which a normal person is not able 

to do.

 TyPeS OF rOBOTS

Aerospace:

This is a broad category. It includes all sorts of flying robots—the SmartBird robotic seagull 
and the Raven surveillance drone, for example—but also robots that can operate in space, 
such as Mars rovers and NASA’s Robonaut, the humanoid that flew to the International 
Space Station and is now back on Earth.

Figure 7.2: Actuator Figure 7.3: Pneumatic Air Muscles Figure 7.4: Muscle Wires

George Devol developed the first digitally 
operated Robot.

REMEMBER IT!
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Consumer robots

These robots are available for purchase and are kept as toys. They also carry out other jobs 
and errands for people. Aibo the robotic dog and Roomba the vacuum machine are two 
examples.

disaster response Tools

Robots used in disaster response do 
hazardous or dangerous duties, such 
as looking for survivors after a tragedy. 
Consider the Packbot, a mobile robot used 
for hazardous material disposal and other 
risky duties. It can drive through mud, climb 
stairs, and function in all weather.

    

Figure 7.5: SmartBird

Figure 7.7: Aibo

Figure 7.6: Raven

Figure 7.8: Roomba

Figure 7.9: Packboat
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Industrial robots

Industrial: The traditional industrial robot 
consists of a manipulator arm designed 
to perform repetitive tasks. An example is 
the Unimate, the grandfather of all factory 
robots. This category includes also systems 
like Amazon’s warehouse robots and 
collaborative factory robots that can operate 
alongside human workers.

medical robots

Systems like the da Vinci surgical robot, 
bionic prosthesis, and robotic exoskeletons 
are examples of medical and health-care 
robots.

 APPLICATIONS OF rOBOTICS

�� Conservation: fighting forest fires.

�� Manufacturing: working in factories, finding and carrying items in warehouses.

�� Companionship: providing company to elderly individuals.

�� Healthcare: assisting in surgical procedures.

�� Delivery: completing food delivery and last-mile fulfilment.

�� Household: vacuuming and mowing the grass.

�� Rescue: undertaking search-and-rescue missions after natural disasters.

�� Military Operations: detecting landmines in war zones.

Kids’ IQ
Do you think Robots can replace Humans?

Figure 7.10: Unimate

Figure 7.11: da Vinci
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Let’s Recall
•	 Robots are artificial agents that behave in the real world.

•	 Robotics is a domain in artificial intelligence which deals with the study of creating 
intelligent and efficient robots.

•	 Robots resemble humans in terms of their physical composition. 

•	 Robots are developed with batteries, Actuator, Muscle wires and sensors.

•	 Robots used in disaster response do hazardous or dangerous duties, such as looking 
for survivors after a tragedy.

      

Upskill Your Intelligence

A. Fill in the blanks.

 1. The study of building effective and intelligent robots is the focus of the .................... 
field of robotics.

 2.  .................... is an example of Medical robots.

 3. .................... are installed in the body of the robots to work like the five senses of a 
human being.

 4. Robots used in disaster response do .................... or .................... duties.

 5. .................... is a domain of artificial intelligence that deals with the study of creating 
intelligent and efficient robots.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. Robots cannot perform the tasks given by a human. 

 2. Aibo is a consumer robot. 

 3. Raven is an example of Disaster response robots. 

 4. Robots look like human beings. 

 5. A robot does not have the ability to sense his environment. 

C.  Answer the following questions.

 1. What is a Robot?

  ..............................................................................................................................................

  ..............................................................................................................................................
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 2. Write the features of the Robots.

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. Describe the types of robots.

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. What are the applications of Robotics?

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. Give two uses of a robot.

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Identify the following robots and their types.

  ............................................        ............................................       ............................................

Team Work

 Team up with your partner. make a working robot 

using cardboard, thermocol or plastic bottle.
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CYBER ETHICS8

Teacher’s 
Note:

Guide students that everything they see on the internet is not true, you have to be very careful 

while sharing the video with others.

At the end of this chapter, students will be able to:

)) Comprehend the concept of cyber security and ethics.

)) Recognise the several kinds of risks related to the internet.

)) Know about piracy and its types.

Learning Outcomes

Warm-up

Observe the following picture and continue the conversation.

What are you doing?

Remember, if you are 
not sure. Please don’t 
share.

I’m sharing the latest news 
about this person.

Why not? Everybody is 
sharing it. It’s viral news.

Are you sure 
about this?

It is wrong to share something you 
are not sure about. Please check of 
sebenarnya.my to make sure the news 
is right before yo share it.

Example: 1
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Hello Friends! Let us learn some 
Cyber Ethics and ways to protect 
ourselves, online.

When computers were first used, there weren’t any guidelines or requirements on how to 

use them. This led to various issues. But when their use spread in every aspect of our lives, 

it became essential to establish some guidelines. At the national and international levels, 

many of these regulations have been codified as laws.

The ethical use of computing resources is ensured by computer ethics. It outlines techniques 

for avoiding breaking trademark and copyright laws. Furthermore, it addresses the 

unauthorised dissemination of digital content.We must follow all the standards which have 

been set for the appropriate use of the internet. It should not be used for wrong and illegal 

purposes.

 AvAILABLe rISkS ON The INTerNeT

We must educate ourselves on the risks associated with using the internet as responsible 

users.

Loss of confidentiality of Information

 Hackers are those who take advantage of a computer network or system’s flaws. They are 

able to breach a computer’s poor security. Hackers take advantage of computer systems to 

steal important data. They steal this material to strike revenge on others, gain fame, or for 

financial gain. Hackers have cost organisations all over the world significant financial losses.

Fake information

It is quite challenging to verify the accuracy of the information because there is so much of it 

available online. On social networking platforms, many internet users create fake accounts.

They think they can disseminate rumours in this way and get away with it. Rumours have 

frequently ignited riots and hatred in the past. These rumours 

are disseminated via various social media apps. Make sure to 

check the information from reliable online sources or question 

individuals you trust before you believe any kind of information.

Let Me Answer
Have you ever come across any 
fake information?
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Computer virus

Many professional organisations use the internet to do their business online in the twenty-
first century. Companies and governmental organisations both save their important 
information online. In order to disrupt this knowledge, individuals who want to steal or 
destroy it construct a lethal virus. One of the most popular methods used by these individuals 
to propagate the infection is the internet.

 CyBer CrIme

Cyber Crime is any crime that is committed using the computer and the internet where the 
computer may be the target, tool, both. They involve criminal activities such as theft, fraud, 
forgery and defamation. Cyber crimes are addressed by the Information Technology Act, 
2000. Cyber policies take care of cyber crimes.

Cyber Stalking

Stalking is the recurrent practice of unwanted monitoring 
or harassment with the intent to manipulate or influence 
the victim. Online and offline stalking are both against the 
law.

Cyberbullying

The act of harassing a person through electronic 
media is known as cyberbullying. In this case, the 
attacker uses intimidating messages to attempt to 
corner the victim.

Identity Theft

It is a type of cybercrime when the culprit creates a false 
identity in order to obtain financial benefits like credit 
cards and loans, among other things. They borrow 
money from a financial institution, fail to repay it, and 
inflict significant financial losses on the institution in 
the name of another person. For example, fraudsters can 
copy or adhar card information or bank credentials and 
get the loan cleared in our name.

Spamming

You must have noticed when looking through 

Let Me Answer
What can be the ill-effects of 
cyberbullying?

There is a hacker attack every 39 seconds

REMEMBER IT!
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your mailbox that there are numerous emails from unidentified email 

addresses. Who is the sender of these emails and how did they get our 

email addresses? The majority of contemporary browsers come with an 

internal application that can recognise these emails and put them in 

a different folder. Spam is the term for these unwelcome emails. They 

are generally sent in large numbers for commercial 

advertising. Spamming involves sending the same 

messages to email users all over the world in millions. 

Since spam may be used to spread malware such as 

trojan horses, viruses, worms, spyware, and coordinated 

targeted phishing attempts, it poses a major security risk.

 CyBer SeCUrITy

Any computer that is connected to the internet is exposed to a wide variety of technological 

dangers. We cannot ignore the reality that we constantly feel scared by the idea that a 

computer genius may utilise dubious methods to learn crucial information about your 

financial situation, interfere with it, or otherwise misuse it.This is where cyber security steps 

in. Because it tries to protect sensitive data, computer security is crucial. It tries to protect 

the confidentiality, integrity, and accessibility of important data kept on computers.

 USINg PASSWOrdS

It’s crucial to use passwords properly since they serve as your first line of security against 

hackers and imposters.

Follow some of the tips given below.

�� Never disclose your password to a third party.

�� Never use the same password across all the accounts.

�� Make passwords that are simple to remember yet difficult to decode.

�� The password must include at least 12 characters, including capital letters, digits, and 

symbols.

�� Make sure your devices have anti-malware software and are secure.

�� Use a fingerprint or “password” on your phone as well.

Do You Know?
Spam accounts for 14.5 billion messages 
globally per day. In other words, spam 
makes up 45% of all emails.
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 SAFeLy ACCeSSINg WeBSITeS

Our lives have been completely transformed by the internet, which now allows us to read 

the news, watch movies, conduct research, plan our vacations, buy and sell, and perform 

a variety of other daily tasks. However, it comes with a lot of risks that could arise from 

viewing a malicious website or unintentionally disclosing sensitive information. Malware, 

which includes both spyware and viruses, may be involved.

Some points to keep in mind while accessing a website:

�� When using the websites, use common sense.

�� Verify the website’s address, contact information, and email address to ensure its 

legitimacy.

�� The URL of the website might look authentic. Keep an eye out for slight spelling 

variations.

�� Use the most recent versions of your browser and antivirus software.

�� Always keep in mind to log out of the website after finishing your transaction.

Kids’ IQ
Which things will you keep in mind while creating a password?

Let’s Recall
•	 The ethical use of computing resources is ensured by computer ethics.

•	 Hackers are those who take advantage of a computer network or system’s flaws.

•	 Cyber Crime is any crime that is committed using the computer and the internet.

•	 Stalking is the recurrent practice of unwanted monitoring or harassment with the 
intent to manipulate or influence the victim.

•	 Any computer that is connected to the internet is exposed to a wide variety of 
technological dangers. 

•	 Never use the same password across all the accounts.
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Upskill Your Intelligence

A. Fill in the blanks.

 1. The ethical use of computing resources is ensured by .....................

 2.  Cyber ethic addresses the .................... dissemination of digital content.

 3. .................... are those who take advantage of a computer network or system’s flaws.

 4. Companies and governmental organisations both save their .................... information 
online.

 5.  Identity theft is a type of cybercrime when the culprit creates a ................ identity.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. Cybercrime is an act of crime in which a computer system is used to  

commit an offence. 

 2. The Internet leads to the exchange of mobiles. 

 3. Hackers steal crucial information from a computer system. 

 4. Blocking someone who is stalking you on the web is a crime. 

 5. In spamming, millions of the messages are sent to different email users. 

C.  Answer the following questions.

 1. What is Cyberstalking?

  ..............................................................................................................................................

  ..............................................................................................................................................

 2. What do you mean by identity theft?

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. Define spamming.

  ..............................................................................................................................................

  ..............................................................................................................................................
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 4. What things to be kept in mind while accessing websites?

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. What is Cyber security?

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Your friend’s fake id has been created with his profile picture and details and the person 
is asking for money from his friends.

 As a friend, what steps would you take in this case?

Team Work

 make a poster in mS word on ‘Cyber Security’.
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INTRODUCTION TO  
APP DEVELOPMENT

9

Teacher’s 
Note:

Guide students that they use various apps on a daily basis but have they ever thought about how 

these applications are developed.

At the end of this chapter, students will be able to:

)) Know different types of apps.

)) Create apps based on the client’s requirements.

)) Develop an app using a thunkable app.

Learning Outcomes

Warm-up

Identify the logos of various apps given below and write the name.

   ........................................................       ........................................................

  ........................................................       ........................................................
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The most common utility item today is the mobile phone. Everyone these days has access 

to a cell phone.

People are using several brands of mobile phones .  These mobile phones are little more than 

miniature handheld computers; they are equipped with memory, storage, and processors, 

as well as a keyboard, touchscreen, and output screen. Similar to how a computer has many 

software applications installed in it, a mobile phone also has many applications placed inside 

its memory. These apps do feature a distinctive User experience that has been masterfully 

created by professionals.

Running many apps loaded on a computing device depends heavily on the operating system. 

Due to the fact that a mobile phone serves as a computing device, every mobile phone has 

an operating system as well. Apps are made to function on the various operating systems 

that they employ.While iPhone apps may be used on iPhones that run iOS, Android apps are 

designed to work on phones and tablets that run the Android 

OS. Most of these apps can be downloaded easily from the 

Google play store on Android phone or through the App store 

on iOS.

 TyPeS OF mOBILe APPS

There are three main types of mobile apps, just as there are various operating systems for 
mobile phones. Let’s learn about these three categories of mobile phone apps.

Native Apps

A native is a person who is connected to a place by birth or who was born there. Native apps 
are created expressly for an operating system on a mobile device. As a result, you can create 
iOS apps for mobile devices running the iOS operating system and Android apps for devices 
running the Android operating system. Native apps are created with consideration for the 
hardware requirements of a mobile device, which have different hardware requirements 
than desktop computers. Numerous coding languages are used to create native apps.

Hello Friends! Let us learn about 
the development of apps.

Let Me Answer
Which app do you use often?
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Advantages

1. Native UI.

2. It can access the features of a device.

3. It is faster and gives better performance.

disadvantages

1. It is expensive to maintain.

2. Updates need to be downloaded.

3. Take up much space in the device.

Web Apps

Apps that can be used 
with a web browser 
are referred to as web 
apps. You don’t need 
to download these 
apps to your phone. 
Even when we select 
the install option, 
all that happens is 
that we download a 
bookmark. The URL 
link will enable easy 
browser access to the 
online application.

Figure 9.1: Pros and Cons of Native apps

Figure 9.2: Pros and Cons of Web apps

LANGUAGES USED

LANGUAGES USED
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Advantages

1. It can be used on all devices since it’s web-based.

2. It is easy to maintain.

3. It doesn’t occupy space in the device.

disadvantages

1. It always needs an active internet .

2. It is totally dependent on the web browser.

3. It may not always integrate with device hardware.

hybrid Apps

Web apps and native apps are combined to create hybrid apps. These apps can be loaded 
on a device much like native apps and have a user interface similar to a web app. Apps that 
are hybrids can be acquired from the iOS or Play stores. Hybrid apps have an app icon, 
display responsive design, and assure fast performance. Although they look native, they are 
essentially web apps that are made to work offline.

Advantages

1. It is quicker and cheaper to make.

2. Loads fast.

3. Requires less code to maintain.

disadvantages

1. It has less power than native apps.

2. Some features might not work on devices.

3. Since each element has to be downloaded, it is slower.

Figure 9.3: Pros and Cons of Hybrid apps

LANGUAGES USED
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 ChOOSINg The rIghT APP FOr deveLOPmeNT

1. development Time

Web apps are the greatest option if you want to make an app that shouldn’t take too long to 
design and your users are okay with using a browser.

2. Limited resources

If you have a limited budget, go with a web app instead of a native app. You can convert your 
application to the Native version after it gains user engagement.

3. Performance

Development of a Native app is the best option if app 
performance is your top priority. Native apps are effective 
in terms of performance and stability and may be readily 
customised.

 deveLOPINg yOUr FIrST APP

In the process of developing an app, each of the app’s component parts is first created, and 
then the entire app is put together. Here, we will learn to create different components of an 
app. 

Let’s start by using the web application ‘Thunkable’ to build a basic user experience for an 
app.

 ThUNkABLe APP

Thunkable is a web-based application that was first made available by Google and has an 
integrated development environment. Anyone with basic computing skills can develop 
Native apps that are based on Android and iOS . It has a GUI based interface which is very 
similar to Scratch. It offers the feature of drag and drop, by which we can easily create an app 
without writing any code.

Starting Thunkable app

Follow the given steps to start the Thunkable app.

Steps:

1. In your browser, type the following URL.

      www.thunkable.com

Let Me Answer
Have you ever noticed the name of the 
app developed while using any app?
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2. To begin, select the start button. You’ll see the screen given below.

3. Use your Google account to log in to the Thunkable application. The following page 
will appear after you check in to the app with your Google account.

Figure 9.5: Sign in

Figure 9.4: Thunkable App Interface
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4. Select “Start Building” option. It will then display the Create New Project dialogue box, 
as seen below. Add the required information and click on Create button.

5. A webpage with a different toolbar and a demo screen will be shown as below.

Figure 9.7: Creating a New Project

Figure 9.6: Start Building your App
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 CreATINg The FIrST APP WITh ThUNkABLe

Follow the given steps to create your first app.

Steps:

1. Scroll down to the Image tool in the design section.

Figure 9.9: Using the Image Tool

Figure 9.8: Thunkable App Development Interface
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2. Place the picture tool in the Layout Screen by dragging and dropping it there. The 
layout screen will look similar to the illustration below.

3. Choose a picture from the Image panel on the right side of the screen. Utilise the Upload 
files option to upload an image from your PC.

4. As soon as the picture has been added to the layout screen. On the Layout Screen, you 
can drag and drop it to reposition it.

5. Scroll down and choose the Label tool in the Design section. Drag it down and drop it 
next to the picture.

Figure 9.10: Inserting Image

Figure 9.11: Positioning Image
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6. From the label panel shown on the right hand side 
of the browser screen,click on the Text option and 
add text of your choice in the textbox. You can also 
change the colour and size of the text using the 
options given in the Label panel.

7. Scroll down and choose the button tool in the Design 
section. Drag it down and drop it just below the label.

8. From the button panel, click on the text option and 
add text  of your choice in the textbox. Various options 
visible in the Button panel allow you to alter the Button 
text’s style and appearance.

Our app’s user interface is now complete. The app interface, 
which consists of an image, a label, and a button, can be seen 
in the  figure.

Kids’ IQ
Sandeep wants to build a mobile application, but he is aware of his limited resources 
and is unsure of the type of app he should build. Help Sandeep choose the app he 
should build while considering his constraints.

Figure 9.12: Inserting Label

Figure 9.13: App Interface

EOI Books
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Let’s Recall
•	 The most common utility item today is the mobile phone.

•	 Most of the apps can be downloaded easily from the Google play store on Android 
phone or through the App store on iOS.

•	 Native apps are created expressly for an operating system on a mobile device.

•	 Apps that can be used with a web browser are referred to as web apps. 

•	 Hybrid apps can be loaded on a device much like native apps and have a user 
interface similar to a web app.

Upskill Your Intelligence

A. Fill in the blanks.

 1. Every mobile phone has an .................... system.

 2. A .................... is a person who is connected to a place by birth or who was born 
there.

 3. The image tool is present in the .................... panel.

 4. An .................... helps the user to interact with an app.

 5. .................... app which saves development time.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. Native apps can be downloaded only from the iOS store. 

 2. A web app doesn’t need to be downloaded. 

 3. Operating systems play a crucial role in running the different apps  

installed on a computing device. 

 4. Hybrid apps are a combination of both web apps and native apps. 

 5. A mobile phone can run without an operating system. 

C.  Answer the following questions.

 1. State the difference between Native and Web apps.

  ..............................................................................................................................................

  ..............................................................................................................................................
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 2. Write the reasons you’ll consider for selecting one type of app and not another.

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. What is a Thunkable app?

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. Write the steps to create an app using Thunkable.

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. What are Hybrid apps?

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Rahul wants to create an app for his business. He doesn’t know much about creating 
apps, just he is well versed with computing skills.

 Suggest to him the platform he should use to create an app. Further, write the steps 

to open it.

Team Work

 Team up with your lab partner and 

create an app on thunkable that enables 

the students to learn the basic english 

grammar. your app should include all the 

eight parts of speech.
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SOUND EDITING WITH AUDACITY10

Teacher’s 
Note:

Assist students in finding the name of the above apps. Also, guide them about the Sound apps 

which enhance the scene making it real, interesting and thrilling.

At the end of this chapter, students will be able to:

)) Comprehend the significance of Audacity

)) Install Audacity

)) Know the user interface of Audacity

)) Import audio files in Audacity

)) Apply sound effects

Learning Outcomes

Warm-up

Identify the logo of the following apps.

   ........................................................       ........................................................

  ........................................................       ........................................................
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 AUdACITy

Installing Audacity on numerous operating systems like 
Windows, Mac OS, and Linux enables you to edit and record 
audio. Audacity was released on May 28, 2000, and since then 
its popularity is on the rise.

 FeATUreS OF AUdACITy

1. Free: Since Audacity is an open-source programme, it can be downloaded for free. It is 
simple to obtain from the internet.

2. Cross-platform support: Audacity includes this feature, allowing you to install it on 
devices running Windows, Linux, or Mac OS operating systems.

3. multi-Track Audio mixing: You can quickly and easily trim a section from one audio 
track and combine it with another using Audacity. Powerful audio tracks can be made 
by combining multiple audio recordings.

4. Navigation Control and zoom: Audacity has a user-friendly design; for instance, 
when using painting software, you can utilise the zoom tool to improve your vision if 
you wish to add colour to an area that is not immediately visible to you. Similar to this, 
in Audacity, you can utilise the zoom tool to enhance a specific area of the track and 
modify it using the numerous audio-enhancing effects that are offered by Audacity. 

5. Speed Adjustments (Tempo): With a simple 
mouse click in Audacity, you may quickly 
increase or decrease a track’s speed.

 INSTALLINg AUdACITy

As we all know, Audacity is a free open-source programme. 
The most recent version of Audacity is readily available online.

Let Me Answer
What do understand by sound?

Let Me Answer
What is the literal meaning of 
Audacity?

Do You Know?
To make a scene more thrilling and interesting, 
a sound editor is used to create symphony and 
desired effect.

Hello Friends! We will learn about 
one of the most popular sound 
editing apps called Audacity.
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Follow the given steps to install Audacity.

Steps:

1. Open the browser application on your computer and type the URL displayed below in 
the address field to download Audacity.

  www.audacityteam.org

2. Once you press enter, the following page will appear: 

3. Click on the download button and select the Windows option.

Figure 10.2: Audacity Windows Download

Figure 10.1: Audacity Home Page



97 Computer-8

4. Open the Audacity installer on your PC by going to the downloads folder. Selecting 
your preferred language will set off the installation process. After choosing your desired 
language, press the OK button.

5. The welcome screen for the setup process will appear; select Next to continue.

6. After reading the licence agreement, press the Next button.

Figure 10.4: Setup Welcome Screen

Figure 10.3: Selecting Setup Language



98Computer-8

7. Set the installation path at this time. To modify the installation directory, simply retype 
the path or press the Browse option.

Click the Next button if you are satisfied with the preset installation path.

Figure 10.5: Licence Information

Figure 10.6: Selecting Installation Destination
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8. The following step is to enter your specific installation options, such as how you want 
Audacity to look on your computer once it has been installed.

Click the Next button after making your selection for the preference.

9. Audacity is now prepared for installation; at this point, you can decide whether to stick 
with the preset options for the installation or alter them. To alter the preferences or to 
continue,  click the back button or the Install button, respectively.

Figure 10.7: Additional Shortcut

Figure 10.8: Ready to Install
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10. On your computer, the setup will extract and install the necessary files.

11. To complete the installation, click the Finish button.

Figure 10.9: Extracting Files

Figure 10.10: Completing Audacity Setup
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The Welcome screen will appear as shown below.

 AUdACITy INTerFACe

Audacity features a user-friendly interface that is 
essentially the same across all operating systems.

Figure 10.11: Audacity Welcome Screen

Audacity was started by Dominic Mazzoni 
and Roger Dannenberg in the fall of 1999 at 
Carnegie Mellon University.

REMEMBER IT!

Figure 10.12: Audacity Interface

Track Control 

Panel

Unpinned Play/

Recording Head

Menu Bar Tools Toolbar

Transport Toolbar

Audio TrackScrub RulerTimeline

Status ToolbarTime ToolbarSelection Toolbar

Device Toolbar

Mixer Toolbar

Recording Meter Toolbar

Play-at Speed ToolbarPlayback Meter Toolbar
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 reCOrd AUdIO USINg AUdACITy

We are all aware that in order to capture audio, a working microphone must be connected 
to, or at the very least built into, the computer.

Follow the given steps to install audio in audacity.

Steps:

1. Choose a recording device for audio from the device toolbar.

2. Check the recording level on the monitoring metre to make sure Audacity and the 
microphone are working together. The intensity of the signal will be stated.

3. When everything is prepared to record audio, click the red button on Audacity’s main 
toolbar. The recording will begin after this.

4. Press the stop button to stop the recording.

5. When you touch the stop button, Audacity will show you the recording.

Figure 10.13: Selecting the Audio Recording Device

Figure 10.14: Monitoring Meter
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You can hear the most recent audio recording by clicking the play button.

 SAvINg AUdIO reCOrdINg

You can save your recording as a Project or Export it to the most popular audio formats 
using Audacity’s many different saving options.

Follow the given steps to save the recording.

Steps:

1. Select Export from the menu options after clicking the File menu, and then choose the 
required option from the list of supported audio formats.

Figure 10.15: Audio Recording

Figure 10.16: Saving Audio Recording

Recording
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2. It will show the Export Audio dialogue box. Click the Save button after entering the file 
name in the File name textbox.

3. The Edit Meta tags dialogue box will be displayed. Add additional information about 
the track in various fields and click on the OK button.

 reCOrd AUdIO USINg AUdACITy

You can add a track from your computer’s hard drive and modify it thereafter adding it to 
Audacity. However, you must import the track first before you can begin modifying it.

Follow the given steps to import a track from your computer’s hard drive.

Steps:

1. Select Import from the menu selections by clicking on the File menu, and then choose 
the Audio option.

2. Find the track you want to import in the select one or more files dialogue box. When 
the desired track has been chosen, select Open to bring it into Audacity.

Figure 10.17: Select one or more files
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 WOrkINg WITh mULTIPLe TrACkS

Multiple tracks may be necessary to work with while doing sound editing. Let’s say we want 
to edit the sound for a scene from a movie where characters are conversing while crossing a 
busy street. We are aware that this scene will include character talk in addition to the regular 
street noises that one hears when walking. We might like to add some background music 
to increase the scene’s impact. Working with numerous tracks at once is necessary for all of 
this.

The act of combining numerous Audacity tracks that are playing simultaneously into a single 
track is known as mixing. When playing or exporting, Audacity automatically combines 
tracks, but it can also manually combine a number of tracks into one within the project.

Follow the given steps to work with multiple tracks.

Steps: 

1. From the file menu, use Import option and import two different tracks that you wish. 

Figure 10.18: Import Track

Figure 10.19: Multiple Tracks
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2. Use the I selection tool from the Tools toolbar and select the portion you want to delete 
from the first track. 

3. You will see that the selected portion is now highlighted with a different colour. To 
delete the selected portion, click on the delete key. Observe that the selected portion 
has been removed from the track.   

4. Repeat step3 to delete the selected portion in the selected track.

Figure 10.20: Working of Selection Tool

Figure 10.21: Deleting Track Portion
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5. You will notice that the timeline of Track Audacity will look the same as the picture 
given below after deleting the selected portions.

6. Let’s select the Timeshift tool and place the remaining part just after track one. 

   

Press the Play button to listen to the track.

 APPLyINg eFFeCTS

There are numerous effects available in the majority of photo editing and presentation tools, 
including PowerPoint software, that may be used to improve the appearance and functioning 
of various items. For instance, we can easily apply various animation or transition effects to 
various objects like text and photos in PowerPoint. Similar to this, we can also use Audacity’s 

Figure 10.22: Tracks Audacity Timeline

Figure 10.23: Working of Time Shift Tool
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many audio effects to enhance the sound quality of an entire track or just a selected section 
of it. 

We’ll quickly go through how to add some audio effects to a track today.

Steps:

1. Utilizing Audacity Timeline’s import function, add a track.

2. Choose the section of the track where the effect should be applied using the Selection 
Tool from the Tools Toolbar. Press the Ctrl-A key combination to add effect to the 
entire track.

3. Now select the Echo menu option by clicking on the effect menu. Then chosen section 
of the track will immediately receive the Echo effect.

Using the instructions above, you can apply a variety of different effects to your audio file.

Kids’ IQ
Karan is working on two tracks; he wants to add the remaining track from track 1 to 
another track in the timeline after deleting a piece of track 1. Provide Karan with the 
tools he needs to complete this task.

Figure 10.24: Applying Effects
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Let’s Recall
•	 Audacity was released on May 28, 2000 and enables you to edit and record audios.

•	 Audacity is a free open-source programme.

•	 You can quickly and easily trim a section from one audio track and combine it with 
another using Audacity.

•	 The act of combining numerous Audacity tracks that are playing simultaneously 
into a single track is known as mixing.

•	 Audacity was started by Dominic Mazzoni and Roger Dannenberg.

Upskill Your Intelligence

A. Fill in the blanks.

 1. Audacity was released on May .....................

 2. Audacity has a .................... design.

 3. In Audacity, you can utilise the .................... tool to enhance a specific area of the 
track.

 4. The act of .................... numerous Audacity tracks that are playing simultaneously 
into a single track is known as mixing.

 5. .................... option is used to add a track to the Audacity timeline.

B. Write ‘T’ for True statements and ‘F’ for False statements.

 1. Audacity is a Paid software. 

 2. Audacity is a cross-platform app. 

 3.  It allows edit of only one track at a time. 

 4.  Play button is pressed to play the track. 

 5. You can’t delete the portion of the track once it’s saved. 

C.  Answer the following questions.

 1. What is Audacity?

  ..............................................................................................................................................

  ..............................................................................................................................................
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 2. How can we install Audacity on our computers?

  ..............................................................................................................................................

  ..............................................................................................................................................

 3. How Audacity is a Cross-platform app?

  ..............................................................................................................................................

  ..............................................................................................................................................

 4. Write the steps to import audios to Audacity.

  ..............................................................................................................................................

  ..............................................................................................................................................

 5. How can we apply effects to the audio using Audacity?

  ..............................................................................................................................................

  ..............................................................................................................................................

Critical Thinking

 Using several Audacity sound effects, kanku has produced a new track and altered 

its audio. She wants to save this track in mP3 format on her pen drive. Aid kanku 

in saving the mP3 version of the track.

Team Work

 Team up with your partner and record an audio of your favourite song using 

Audacity and apply effects to it. Once done, play it in the class.
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Identify the tools and label them. Use these tools in the respective app. Print screen 

the outcomes each time and paste the pictures in a collage-frame in “Photoshop”. Also, 

write their functions in the collage that you’d make.

G a
m e

Fun

1

1.

6. 8.

10. 7.

3.

9.

2.

5.

4.
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G a
m e

Fun

2

Identify the tools and label them. Use these tools in the respective app. Print screen 

the outcomes each time and paste the pictures in a collage-frame in “Photoshop”. Also, 

write their functions in the collage that you’d make.
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